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Introduction 
 Congratulations on the purchase 

of your new F-940 Store It! Gas 

Analyzer.  

The F-940 Store It! Gas Analyzer 

provides rapid and precise 

measurements of ethylene, CO2 

and O2. The Store It! was 

designed for Quality Assurance 

staff to increase shelf-life and 

prevent spoilage of valuable 

produce by monitoring ripening gases throughout the storage 

process.  

The Store It! features an intuitive user interface, making it 

simple to operate right out of the box. Its lightweight, handheld 

design enables users to rely on the Store It! at all stages of 

storage along the supply chain. A built-in data logger stores 

thousands of data points and conveniently transfers data 

through USB or Bluetooth onto a PC or tablet for later analysis. 

With its rapid response time and lightweight handheld profile, 

the F-940 provides a fast, portable verification process for 

atmosphere quality control. Easy to use straight out of the box 

with little or no training, the F-940 is ideal for verifying CO2 and 

O2 levels in Modified Atmosphere Packaging (MAP) applications, 

laboratories, distribution centers, retail centers, storage 

facilities, and shipping containers.  

We hope you enjoy using your F-940 Store It! Gas Analyzer. 
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Features  
 The F-940 features include: 

 Measures C2H4, CO2 and O2 

 Displays results in under 30 seconds 

 Past records stored on the device 

 Handheld and lightweight 

 Internal data logging and storage  

 (WiFi capable SD card) 

 Bluetooth data transfer 

 Battery lasts for 8+ hours 

 Display easily viewed in dimly lit environments 

PolarCept!TM water filter for removing non-ethylene 

hydrocarbons 
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Specifications

F-940 Specifications 
Air Sampling Rate 70 mL/min 

Measuring Rate 
Automated, 1 second intervals to SD 
in Continuous Mode 

Data Storage Removable 16 GB SD and Bluetooth 

Display Sunlight visible transflective LCD 

Operating environment 
0°C - 45°C (0-90% relative humidity, 
non-condensing) 

Power Source 
Removable rechargeable lithium-ion 
battery 

Dimensions 18cm x 13.5cm x 5.5cm 

Weight 0.95kg 

Enclosure Powder coated aluminum 

Sensors 
Ethylene (C2H4) 
SENSOR Electrochemical 
Nominal Range 0-10 ppm 

Full scale resolution 0.1 ppm 

Accuracy ±2% relative ±0.15 ppm absolute 

Lower Detection Limit 0.1 ppm 

Offset Recalibration Daily 

Span recalibration 3 months 

Lifetime 12 months 

  

Carbon Dioxide (CO₂) 
SENSOR Infrared sensor, pyroelectric detector 

Nominal Range 0-100% 

Full scale resolution  0.01% absolute 

Accuracy ±3% relative ±1% absolute 
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Sampling Time 10 seconds 

Calibration Annually 

Lifetime > 5 years 

  

Oxygen (O₂) Sensor Electrochemical 

Nominal Range 0-100% 
Full scale resolution  0.1% absolute 

Accuracy ±2% relative ±.25% absolute 

Sampling Time 10 seconds 

Calibration Bi-annually 

Lifetime 12 months 
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Unpacking the F-940 Store It! 
The F-940 arrives with a hard-sided carrying case, two sets of 

batteries and a charger, a removable SD card, and several 

accessory parts. A sampling port with needle is included for 

taking non-destructive samples from packaging. The sampling 

port is pictured below, connected to the intake. There is also an 

extra Potassium Permanganate Filter (see Maintenance of your 

F-940 Store It!: Replacing the Potassium Permanganate Filter) 

and a Closed-Loop Probe used for sampling from Jars (see 

Applications: Sampling with a Jar). 
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Operating Instructions 
WARNING: Do not store the F-950 without batteries! Charged 

batteries must be present in the instrument to maintain the 

accuracy of the sensors, even when the unit is powered off. 

If the batteries of the F-940 discharge during storage, replace 

with charged batteries and allow the instrument to stabilize 48 

hours before use. There is a small internal battery to maintain 

the bias voltage for the ethylene electrochemical sensor. This 

small internal battery will last for 1 day without the main 

batteries before sensor sensitivity is affected by losing its bias 

voltage. The calibration parameter data is intact with or without 

batteries.  

Loading the Battery 
WARNING: Spring-loaded battery cartridge 

The F-940 uses 18650 Li-ion 3.7V 

3100mAh rechargeable batteries. For 

longer lifespan, charge the batteries at 

0.25A. For a faster charge, charge at 

1A. The batteries must be removed 

from the F-940 to be charged. If the 

batteries of the F-940 discharge during 

storage, replace with charged batteries. 

The Li-ion batteries have little self-

discharge and a lifetime of ~ 3 years.   

To remove the batteries, twist the 

battery compartment cap, located on the bottom of the case. 

The cap can be twisted with fingers or a screw-driver to tighten 

or loosen it. Take care when removing batteries, as the cap is 
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spring loaded. Both batteries should be inserted into the unit 

positive (+) side first (towards intake or top). 

Additional button-top 19670 (or protected 18650) batteries can 

be purchased from your preferred battery vendor if 

replacements are needed. 

 

Basic Operation 
To turn the instrument on, press the green power button. The 

current version of firmware the unit is running is displayed in 

the lower Left hand corner.  

For information on the latest firmware version, please visit the 

F-940 support webpage: www.felixinstruments.com/support/F-

940 

The battery meter is listed on the lower right hand side of the 

display. 

The main menu displays the following options: Measure, Setup, 

and File. If the power button is pressed, the display will prompt 

for confirmation before shutting down the F-940.  

To scroll between menu 

items in the list, use the Up 

and Down arrows. To select 

an option from the menu 

list, use the Right arrow. To 

exit, use the Left arrow.  

Measurement Modes 
Two measurement modes are incorporated into the F-940 Store 

It! 

Felix Instruments 

Measure  
Setup 
File 
F-940 Vx.x.x.x 

http://www.felixinstruments.com/support/F-920
http://www.felixinstruments.com/support/F-920
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 Continuous mode 

 Trigger Mode 

Continuous mode measures the air entering through the input 

of the instrument continuously without stopping. Continuous 

mode can be used with or without the sample port attached to 

the front of the instrument. Data is saved to a file every one 

second on the F-940. 

Trigger mode measures the air entering through the input of 

the instrument, the pump will run and the sample will enter 

until a stable reading has been achieved. The final values will be 

displayed on screen and saved to the SD card. The pump will 

then turn off until the user initiates a new measurement. 

Trigger mode can be used with or without the sample port 

attached to the front of the instrument. See the specifications 

page for standard sample volume. 

To change between modes, Navigate to Setup > Mode from the 

main menu.  

Measure 
From the main menu, press the right arrow when the word 

‘Measure’ is highlighted to enter the measurement display 

screen. All measurement parameters are saved to the SD card 

every 1 second in continuous mode. When the SD card is not 

present, the data will not be saved. The unit also comes 

equipped with Bluetooth technology, designed for wireless 

transfer of data (see Transferring Files). 

If sampling very high concentrations followed by very low 

concentrations, allow the instrument to purge internal gas for 

the most accurate measurements.   
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Continuous Mode 
When in continuous mode, a graph of the concentration of each 

gas can be viewed over time. The default graph shown is the O2 

concentration in ppm. To view the C2H4 or CO2 graph, simply 

use the up and down arrows to scroll through the graphs. The 

current gas being graphed is shown on the top of the screen 

with the concentration in large font as shown below.  

 

The x-axis of the graph represents time elapsed. The y-axis of 

the graph displays the range of the concentration in % for CO2 

and O2, and the dynamic range is labeled at the top. The y-axis 

scale is set by the highest value shown in the active display.  

The graph begins on the Left side and moves toward the right as 

more data accumulates. The total measurement time is 

displayed below the graph. The flowrate (mL/m) is displayed at 

the bottom.  

Trigger Mode 
A measurement in trigger mode will initiate a small volume 

sample taken over several seconds until the reading is stable. To 

begin, press the square start button as prompted to measure. 

This will turn on the pump before drawing in sample gas. Trigger 
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mode will take longer to stabilize if the concentration is in a 

different range from the last sample.  

 

 

The results will be saved to the SD card. Press the square start 

button to begin another measurement. Press the Left arrow to 

exit to the main menu.  

Taking a Measurement 
Assemble the probe and connect the needle probe tubing to the 
intake of the F-940. Twist on a hydrophobic filter to the end of 
the tubing. The filter will prevent any moisture or debris from 
entering the instrument. Finally, attach a sterile needle to the 
filter. Depending on the application, needles can be re-used.   
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From the main screen, select ‘Measure’ and then the right 

arrow button. This will initiate a measurement in either mode. 

The F-940 will run either continuously (continuous mode) or 

until the minimum stable sample volume has been reached 

(trigger mode). Press the Left arrow button to return to the 

measurement screen.  

Setup Menu 
Use the right arrow to enter the Setup Menu from the Main 

Menu screen. The following options are available: 

Mode 
Calibration 
Set Zero 
Date & Time 
RH Conversion 
GPS 
Language 
Factory Setup 

Setup > Mode 
The Mode menu contains two options: 

Measure: switches between Continuous and Trigger mode.  

Connection: switches between USB Storage (default), Bluetooth 

(enabled in future versions), or USB Ctrl (enables 

communication to controller software).  

To change, use the Up/Down arrows to cycle through the mode 

options. Press the Left arrow to exit to the main menu. 
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Setup > Calibration 
The calibration feature allows the user to set zero and set span 

without the use of a computer or G.A.S. (Gas Analysis Software). 

Unlike Setup > Set Zero in the next section, a zero standard gas 

is required as well as standard gases for the set span process. 

The F-940 Store It! Will prompt the user to set up a zero gas, 

which can be achieved by feeding 100% Nitrogen (N2) gas to the 

intake. The unit will countdown to set zero. The following 

screen will prompt the user to setup a span gas, which is a 

known standard gas used for the span calibration process. For 

more information on standard gases used for calibrating the 

Store It! Refer to the calibration section in the ‘Maintenance of 

your F-940 Store It!’ section. 

Setup > Set Zero 
The set zero process sets a new baseline, or zero, for the 

sensors: 

C2H4 

CO2 

O2 

Mode 

Measure             Trigger 

Connection  USB Storage 
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Set zero should take place weekly for the Ethylene (C2H4) and 

Oxygen (O2) sensors and every six months for the Carbon 

Dioxide (CO2) sensor to maintain maximum performance. To set 

zero, first press the right arrow to select the sensor. Wait for a 

beep to verify the set zero process was completed. The set zero 

process uses ambient air to set zero for O2, an internal 

Potassium Permanganate jar to set zero for C2H4, and an 

external conditioning chamber full of Soda Lime to set zero for 

CO2. Setting zero is important in establishing a daily zero 

baseline for the sensors. Both the O2 and C2H4 set zero process 

do not require any attachments unlike the CO2 set zero process. 

The following instructions can be followed to set zero for the 

CO2 sensor: 

The F-940 is shipped with an external conditioning tube and a 

jar of Soda Lime. Fill the conditioning tube with the Soda Lime 

granules, keeping the ends packed with the cotton ball filters. 

Connect the external conditioning tube to the inlet and outlet of 

the F-940, seen below. Continue through the standard set zero 

process. The F-940 will prompt the user to use “0ppm/N2”. The 

Soda Lime external conditioning tube creates a 0 ppm CO2 

environment, alternatively, the user can connect N2 gas, which 

provides a 0 ppm CO2 environment as well. 

*The Soda Lime external conditioning tube is used for the CO2 

Set Zero process only. 
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Next, verify the set zero calibration by measuring ambient air. 
Run the set zero calibration again if the verification is not 
successful. 
 

Setup > Date and Time 
To adjust the date and time, use the Right and Left arrows to 

move between Month/Day/Year and Hour/Minute/Second and 

use the Up and Down arrows to change the values. To exit, use 

the Left arrow to back out of the screen and return to the Setup 

menu.  

 

 

 

 

 

Date & Time 

MM/DD/YYYY      hh : mm : ss 

04/21/2016  17 : 01 : 43 
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Setup > RH Conversion 
The Setup RH Conversion menu is used to correct for the 

temperature sensor being inside F-940 housing. This causes the 

temperature sensor to reflect the temperature of the F-940 and 

not the ambient temperature, which is usually several degrees 

above ambient. The Relative Humidity is calculated based on 

the temperature value.  

Enter the correct ambient temperature in degrees Celsius, 

measured from an external 

temperature sensor. To use 

the entered temperature for 

RH calculations, “use sample 

T” should be set to “Yes.”  

The current (internal RH) and 

corrected (sample RH) are 

displayed at the bottom of 

the screen.  

 

Setup > GPS 
The GPS sensor inside of the F-940 Store It! can be used to 

record latitude and longitude +/- 10 meters. The instrument 

should be operated outside, without overhead obstruction for 

best GPS performance. The Setup > GPS menu turns on/off the 

GPS sensor and displays the current GPS data.  Data is also 

saved to the SD card as a .csv file. 

RH Conversion 
Enter Sample T(C)       20.0 
Use Sample T                 Yes 
(for measurements) 
 
Internal RH (%)             43.6 
Sample RH (%)              21.3 
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Setup > Language 
The Language menu will display options for: 

English 

Spanish 

Portuguese 

Use the Up and Down arrows to select. 

Setup > Factory Setup 
The Factory Setup menu is used to: 

Restore: Restores factory defaults 

Backup:  Backs up current parameters. “Backup device’s 

                 configurations?”: NO or YES 

File Menu 
In the File Menu, the user can manipulate files on the F-940 

Store It! The F-940 will by default save to the most recently 

used file on the instrument. The file menu contains: 

Select 

GPS 

Enable GPS  Yes/No 

Acquiring GPS data….. 

Longitude                             122.558 

Latitude                                    45.59 
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Create 

Delete 

Review 

All files created by the F-940 are .csv (comma separated value) 

file extensions.  

To view data on a computer, simply insert the SD card into a 

computer’s SD card reader (always power off the F-940 before 

removing the SD card). The computer should automatically 

detect the SD card as a new storage device enabling access to 

measurement data from any computer. The mini-USB port can 

also be used to establish a USB connection with a computer to 

transfer data from the F-940 Store It!  

File > Select 
File Select displays a list of .csv files that exist on the F-940 Store 

It! SD card. Use the Up/Down arrows to move between files, 

and right arrow to select a file to which new data will be saved. 

If the unit is powered on and no file is selected, the data will be 

default saved to the file data.csv. In the file, each data point is 

labeled with time and date for easy sorting.  

 

Select 

Data . csv 

16_04_04_0 . csv 
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File > Create 
Pressing the Right arrow when ‘Create’ is selected will create a 

new file according to the naming scheme programmed on the 

instrument, XX_XX_XX_X or Year_Month_Date_Ordinal. After 

pressing the right arrow, go to File > Select to see the list of files 

on the SD card. There will be a new file in the list with the 

current date.  

File > Delete 
File Delete displays a list of files that exist on the F-940 Store It! 

SD card. Use the Up/Down arrows to scroll between files and 

use the right arrow to delete the selected file. A message will 

appear: “Delete File?” Press the Left arrow for No, leaving the 

file intact. Press the Right arrow for Yes, deleting the file.  

 

File > Review 
File Review displays a list of files on the SD card and allows you 

to view the data contained in the files. Use the Up/Down arrows 

to scroll between files and the right arrow to enter the selected 

file. When reviewing trigger mode files, the software can 

support viewing up to 10 records at a time. The data.csv file is 

the F-940 default file used to store data when no other file is 

selected.  

Delete 

Data . csv 

16_04_04_0 . csv 
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After selecting a file name, the measurement mode with time of 

the measurement and gas concentration will appear for Trigger 

mode readings. Use the Up and Down arrows to highlight a 

measurement and the Right arrow to enter the measurement 

and see the more detailed data, including Date, Time, O2 and 

CO2 concentrations, Mode and Sample Volume.  

Transferring Files 
Open the saved data files on the SD card using Microsoft Excel 

or Notepad. Data files are saved as .csv file extensions (comma 

separated values). The following figure is an example data 

spreadsheet. Data values included are the date and time of the 

measurement, the measurement mode, the CO2 concentration 

in percent, the O2 concentration in percent, the temperature of 

the gas stream in degrees Celsius, the relative humidity (RH) of 

the gas stream in percent, the flow rate of the gas stream in 

milliliters (mL) per minute, and GPS data. 

 

  

 

SD CARD 
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Example spreadsheet data from an F-940 Store It!  

 

 

REMEMBER: Always save the data files to the computer before 

making changes or starting analysis. *Raw output field 

designations: Raw C2H4, Raw O2, Raw CO2, CO2 Ref, Zero 

Baseline, Temp (10x), RH (10x), Battery Voltage, Pressure (mbar) 
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Wireless SD Memory Card Operation 
These instructions are meant to accompany the instructions 

supplied by the vendor for Toshiba FlashAir™ W-03 to use 

specifically with the F-940 Store It! Gas Analyzer, which can be 

similarly applied to other Felix Instruments products. 

1. Install FlashAir™ Wi-Fi card software appropriate to the 

SD card. 

a. Visit https://www.toshiba.co.jp/p-

media/english/download/wl/software02.htm to 

download the software for configuring the Wi-Fi 

card and obtain vendor operation instructions. 

2. Insert the Wi-Fi card onto a personal computer (PC). 

3. Open the “FlashAirTool” on your PC to configure the SD 

card. 

4. Follow the configuration instructions prompted by the 

“FlashAirTool”. 

5. For additional guidelines, access the “Help” menu inside 

the “FlashAirTool” software. 

 

https://www.toshiba.co.jp/p-media/english/download/wl/software02.htm
https://www.toshiba.co.jp/p-media/english/download/wl/software02.htm
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6. The Wi-Fi card can be enabled in “internet pass thru 

mode”, outlined in the following documentation 

provided within the FlashAirTool software: 

 Go to Network Settings on the main menu 

Check Internet pass thru mode 

This function is available for FlashAir™ W-03 

and FlashAir™ W-02 (Ver. F19BAW3AW2.00.02 

or later) cards. 

 

When this function is enabled, the FlashAir™ 

card can be used like a router, by allowing 

another access point to be connected via the 

card. 

When an internet access point is connected, 

images stored on the FlashAir™ card can be 

viewed, and the internet can also be accessed. 

This is convenient when, for example, uploading 

image files downloaded form a FlashAir™ card 

onto social networking services, as there is no 

need to change the Wi-fi device network 

settings on your smartphone. 

 

 

* CAUTION: If you want to connect to the 

internet without using the internet pass thru 

mode, the wireless LAN setting connection on 
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your smartphone or other device must be 

changed from the FlashAir™ card to the internet 

access point. 

Check the “Enable internet pass thru mode” 

checkbox to enable “internet pass thru mode”.  

o Access Point SSID 

Sets the SSID of the internet access 

point. 

Enter the SSID for the access point that 

you will use. An SSID of up to 32 

alphanumeric characters can be 

entered. 

o Access Point Password 

Set the internet access point password. 

Enter the password for the access point 

that you will use. 

o In your browser, enter http://flashair to 

view or stream your files 

 

For more information on the Toshiba FlashAir™ W-03 Wireless 

SD Memory Card, contact the application vendor at 

https://www.toshiba.co.jp/p-media/wwsite/contact.htm, 

 

 

http://flashair/
https://www.toshiba.co.jp/p-media/wwsite/contact.htm
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F-940 Store It! Menu Map 
Below is a map of the F-940 Store It! Two Gas Analyzer menu 

system. Press the right arrow to enter a menu and the Left 

arrow to exit.  
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G.A.S. Gas Analysis Software 
G.A.S. software enables the user to not only calibrate the F-940 

Store It!, but also view graph displays of measurements, 

download, edit and add notes to files, create upper and lower 

thresholds for quality monitoring, and remotely navigate 

through the F-940 Store It! menu system. 

A. Download the F-9x GAS_LAB_setup.exe from 
https://felixinstruments.com/support/F-940/software/ 

B. Install 
C. Launch the downloaded G.A.S. program 

  
There are two ways to connect the F-940 Store It! To the G.A.S. 
program: Bluetooth or USB cable connection.  
 

 
 

1. For USB cable connection, move ahead to step 4. For 
Bluetooth connection, on your F-940 Store It!, navigate to 
Setup > Mode > Connection > Bluetooth. On your 
windows pc navigate to Settings > Devices > Bluetooth 
and pair your computer to the F-940 Store It!  
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2. Verify that the passcode matches between the F-940 

Store It! and the computer, accept each. 

 

3. Once verified, navigate back to G.A.S., the program will 
initiate a connection with the F-940 Store It! 
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4. Once connected, your device serial number should appear 

in the upper left hand corner of the window, click on the 
serial number, you are now ready to interact with the F-
940 Store It! Click on the grey and blue square in the 
upper right hand corner to dis-connect or re-connect. 
 

 

 
Menu System 
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The following will describe the menu system functions and 
symbols: 
 

  
The ‘Files’ menu allows viewing of all files saved to the F-
940 Store It! 
 
 
The ‘Measurement Monitor’ menu displays 
measurements graphically in real time.  

 
  The ‘Control Panel’ menu displays toggle keys which 

allow the user remote control of the F-940 Store It! 

 

 The ‘Calibration’ menu navigates the user through the 

calibration process for both set zero and set span. 

 

Files   

The files menu will display all files saved to the SD card of the F-

940 Store It! 
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Just select the file of interest and choose whether to download 
the file from the device, 

 
 
Or open a saved file from your pc. 

 
  
When the document appears on the right hand column, select it 
to view and make edits in the 'Note' section.  
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Once done reviewing and editing your data, select the save icon 
to save your changes. These changes will be saved to your pc. 

 
 
 
Measurement Monitor   
 
The Measurement Monitor menu allows the user to view a 
graphical live feed of measurements taken on the F-940 Store 
It! This feature will display the measurement mode being used, 
the selected gas, temperature, flow, and RH with the option to 
toggle between CO2, O2 and C2H4. Zoom-in and zoom-out 
display can be adjusted as well as the time interval. Left click on 
the line to see information on the data point! 
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When Trigger mode is selected, the measurements will display 
upon completion in consecutive rows where the user can again 
edit and add notes to the data. 

 
 
Control Panel   
 
The Control Panel Menu allows the user to control the F-940 
Store It! From a computer using a series of toggle keys seen 
below. 
 

 
By pressing up or down, the user can navigate through the file 
menu to change settings on the unit and use the square button 
to take a measurement. 
 
Calibration 
   
The Calibration menu enables a two-point calibration process 
for the F-940 Store It! Including Zero Calibration and Span 
Calibration. The set zero process will require known standard 
gas of 100% Nitrogen (N2) gas to set a zero baseline. Next the 
user will be prompted to connect a known standard gas to set 
the span for your sensors. We suggest the following: 
 
C2H4 Set Span: 5 ppm C2H4 standard gas 
CO2 Set Span: 95% CO2 standard gas 
O2 Set Span: 50% O2 standard gas 
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Each sensor will require its own standard gas for calibration. 
After the set span is complete it is best practice to verify your 
calibrations were successful by reading the standard gas to 
ensure accuracy. 
  

 
  
  
  
Settings 
 
G.A.S. offers a settings menu allowing the user to switch 
between continuous and trigger modes, as well as setting 
thresholds for QA monitoring. 
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The user has the flexibility to create a customized validation 
profile, creating unique profile names and threshold values for 
each gas of interest, useful for quality monitoring! 
  

 
  
Simply "apply validation profile" created after selecting your 
customized validation profile, and then proceed to see your 
results in the Measurement Monitor display. 
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Firmware Update 
To update the firmware on the F-940 Store It!, you will need to 

download and install G.A.S. as outlined in the previous section. 

Launch the software, connect your device and select “Help”. 

 

 

This will reveal a menu with the option to update your 

firmware. 
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Once “Upgrade Device Firmware” is selected, the software will 

outline a series of steps for the upgrade. 

 

Follow the instructions provided in steps 1 and 2, step 3 

requires the selection of a .dfu file, which can be downloaded 

from: https://felixinstruments.com/support/F-940/software/ 

Once the file is downloaded to your computer and selected in 

step 3, click install as prompted in step 4. 

You will be prompted to wait while the firmware upgrades. 

 

Followed by a confirmation that the firmware uploaded 

successfully. Press “OK” and proceed to power on the unit by 

https://felixinstruments.com/support/F-920/software/
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pressing and holding the power button for 10 seconds. You’re 

done! 

 

Maintenance of your F-940 Store It! Gas 

Analyzer 
 

WARNING: If you plan to store this device for longer than 1 

month, follow the instructions below (Steps 1-3) on how to 

disconnect the O2 sensor from the board. This will prolong the 

life of the O2 sensor. 

 

Replacing the Oxygen (O₂) Sensor 
The oxygen sensor has a life span of one (1) year, and the 
replacement of the sensor is simple and quick. To purchase the 
sensor from Felix Instruments contact 
sales@felixinstruments.com. To replace the sensor refer to 
images on following page: 
 

1. Turn off the F-940 Store It! and remove the bottom 
rubber mat.  

2. Remove the battery cap (it’s spring loaded!) and 
unscrew the black bottom plate of the F-940.  

mailto:sales@felixinstruments.com
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3. Unplug the red and black cable connector by gently 
pulling the fastener out the end of the O₂ sensor. 

4. Unscrew the O2 sensor (counter-clockwise). 
5. Screw in the new sensor (clockwise) until you feel a 

resistance—not too tight! 
6. Plug in the cable connector by pressing the white 

fastener into the end of the new O2 sensor. 
7. Screw the bottom plate into position, and fasten the 

battery cap. 
8. Place the bottom rubber mat—and congratulations 

you’ve done it! 
9. Photos of the process are below. 
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Replacing the Potassium Permanganate Filter 

(KMnO4) 
The Potassium Permanganate will expire after prolonged use 

and is easy to replace. The small black jar is the KMnO4 filter, 

just unscrew the bottom plate of the F-940 unit after removing 

the battery cap, unscrew the filter, screw in the replacement 

and you’re done! Screw back into place the bottom plate and 

finally the battery cap. 
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Calibration 
Full set span calibrations should take place every three months 

for the C2H4 sensor, annually for the CO2 sensor and bi-annually 

for the O2 sensor. Always set zero before setting span. If you 

have not already done so, download the G.A.S..exe package 

setup software from 

http://www.felixinstruments.com/support/F-940 and install it 

on your computer. See “G.A.S. Software” section. For C2H4 

calibration standard gases, we suggest 5 ppm C2H4 and a 

verification gas of 2 ppm, for CO2 calibration standard gases, we 

suggest 95% CO2 for the set span procedure and a verification 

gas at a lower value, like 16%. For O2 Calibration standard gases, 

we suggest 50% O2 for the set span procedure and a verification 

using ambient air (20.9% O2). 

The F-940 allows the user flexibility with calibrating, there are 
two methods for calibrating: utilizing the computer-free 
calibration method through on-device adjustments under Setup 
> Calibration on the F-940, OR by using the computer software 
program: G.A.S. (Gas Analysis Software). 
The G.A.S. Calibration menu also enables a two-point calibration 
process for the F-940 Store It! Including Zero Calibration and 
Span Calibration. 
  

http://www.felixinstruments.com/support/F-920
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Set zero should take place weekly for the Ethylene (C2H4) and 
Oxygen (O2) sensors and every six months for the Carbon 
Dioxide (CO2) sensor to maintain maximum performance. The 
set zero process does not require G.A.S. and can be done 
following the processes outlined in the “Setup > Set Zero” 
section of the user manual. Set zero optionally CAN be done 
with G.A.S. utilizing 100% N2 gas (which represents a 0% CO2, 
C2H4 and O2 environment).  
  
After setting zero, select "Span Calibration" and follow the 
instructions outlined in the software to complete the Span 
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calibration process, a diagram outlining how to connect your 
standard gas will display.  
 
The timer is defaulted to 3 minutes, which is typically a 
sufficient stabilization period, if a longer stabilization period is 
needed, increase the timer to 5 minutes. Press start and wait 
for the calibration process to complete.  
 

 

 

After pressing "Start", you will see the following prompt 
reminding the user of the set Zero process. 
  

 
  
If you have already completed the set zero process, press "Ok". 
Another prompt will appear asking the user to put the device in 
Continuous Monitor mode (On the F-940 Store It!: Setup > 
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Mode > Measure > Continuous). Then navigate to the main 
menu and begin measuring. 
  

 
  
Press "Ok". The G.A.S. software will begin the calibration 
process and count down. 
 

 

Once the calibration is completed, a green verification can be 
seen above the start button. 

 
Following step 6 of the instructions listed, you should now verify 
the calibration was successful by taking a reading of the 
standard gas used in the process. The reading should fall within 
specifications outlined in the beginning of this manual. 
 
Continuous Mode Verification *After Set Span 
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The following procedure is to check whether the sensors were 
calibrated to read within spec of the actual gas value. For C2H4, 
O2 and C2H4, refer to the specifications page.  

 
It is highly recommended that this step be performed after 
one full day has passed since the calibration was performed. If 
this step is not performed, accuracy of the calibration cannot 
be verified. 

Connect and read each gas and record the results here after 
three minutes (at least) of measure time. If any of the values are 
out of specification, check your procedure and recalibrate the 
sensor again. 

Gas Concentration Pass/Fail 

Air (Air is ~20.9% O2) 20.9% O2 □Yes      □No 

CO2 Verification Gas 
 

□Yes      □No 
O2 Verification Gas Can use Air □Yes      □No 

C2H4 Verification Gas 
 

□Yes      □No 

 
For information on sourcing known gases required for 
calibration, please refer to the following website to inquire 
about your region: 

https://www.airliquide.com/group/where-we-operate
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Applications 

Sampling with a Jar 
The F-940 comes with an extra accessory sample probe for 
creating a closed-loop system for sampling enclosed headspace 
in a sealed container. The example below displays a glass jar 
with a built-in septum for easy insertion of each sample probe. 
The standard sample probe is connected to the intake/inlet of 
the F-940 while the closed-loop sample probe is connected to 
the outlet. By creating a closed loop, the rigid jar will not 
pressurize by the displaced sample gas removed from the jar. 
The gas will be drawn into the F-940, analyzed by the sensor, 
and then re-circulated back into the jar through the closed-loop 
sample probe. For larger jars/containers, CO2 gas may settle to 
the bottom. This can be compensated by adding a small 
circulation fan inside the jar or by lying the jar on its side closer 
to the sample syringe.  
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PolarCept 
It is recommended to use the external PolarCept filter when 
measuring a mixture of gas 
(such as when sampling fruit) 
or interfering gases may be 
reported by the instrument. 
The PolarCept filter is 
recommended for Trigger 
Mode. PolarCept should only 
be used with 1.5 mL of 
distilled or deionized water.  
The PolarCept filter consists 

of a plastic molded housing, 

hydrophobic filter and O-ring. It is attached to the sample probe 

in place of the hydrophobic filter and utilizes the same sample 

probe needle at the end. A small plastic syringe is used to fill 

and empty the PolarCept filter. Once the hydrophobic filter and 

O-ring are in place it should be very difficult to remove it and 

create a leak-proof seal. Additional hydrophobic filters are 

included as replacements, when the filter is soaked with water 

or damaged during removal, replace the filter.   

After measuring, the water in the PolarCept filter will become 

saturated with trapped interfering gases and should be replaced 

with fresh distilled water. Saturation rates will depend on the 

amount of interfering gases present in the sample environment. 

The table below shows example saturation times when 

measuring headspace of bananas (with a maturity index of 5) in 

Continuous Mode. This sample contains various mixed 

hydrocarbons, ethylene and VOCs.   
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VOC concentration PolarCept saturation (min) 

3 ppm 20 

100 ppm 1 

 
To fill the PolarCept filter, attach an empty syringe to the 

hydrophobic filter. The plunger of the syringe should be 

completely depressed. Lower the PolarCept over a cup of 

distilled water and draw in 1.5 mL with the syringe. Attach the 

sample needle and tubing. To empty the PolarCept, re-attach 

the syringe and push the water out of the PolarCept housing.   

To properly use 

PolarCept, keep the 

sample needle 

pointed down while 

measuring. The water 

in the filter should 

“bubble” as the gas 

sample is pulled 

through, trapping interfering gases.   
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F-940 Production Test Check Sheet 

SERIAL NUMBER:  

Firmware Version:  

 

 

 

 

 

 

NOTES:                                                                                                       
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FELIX INSTRUMENTS HARDWARE 

WARRANTY 
 

Important: Please Read! 
 
Seller’s Warranty and Liability: Seller warrants new equipment 
of its own manufacturing against defective workmanship and 
materials for a period of one year, of a single shift operation, 
from date of receipt of equipment - the results of ordinary 
wear and tear, neglect, misuse, accident and excessive 
deterioration due to corrosion from any cause is not to be 
considered a defect. Any defect must be called to the attention 
of Felix Instruments, Camas, Washington, USA, in writing, within 
90 days after receipt of the unit. 
 
Seller’s liability for defective parts is limited to the repair or 
replacement of any part of the instrument without charge, if 
Felix Instruments’ examination discloses that part to have been 
defective in material or workmanship, and in no event shall 
exceed the furnishing of replacement parts F.O.B. the factory 
where originally manufactured. No equipment may be repaired 
or altered by anyone not authorized by Felix Instruments. 
 
Material and equipment covered hereby, which is not 
manufactured by Seller, is to be covered only by the warranty of 
its manufacturer. Seller shall not be liable to the Buyer for loss, 
damage, or injury to persons (including death), or to property or 
things, whatsoever, including, but without limitation, products 
processed by the use of the equipment; or for damages of any 
kind or nature (including, but without limitation, loss of 
anticipated profits), occasioned by or arising out of installation, 
operation, use, misuse, nonuse, repair, or replacement of said 



F-940 Instruction Manual rev. 10-24-2016 
 

1554 NE 3rd Ave, Camas, WA 98607, USA                               50 

Phone: (360) 833-8835   
sales@felixinstruments.com  
www.felixinstruments.com 

material and equipment, or out of the use of any method or 
process for which the same may be employed. The purchaser is 
to pack, ship, or deliver the instrument to Felix Instruments, in 
Camas, Washington, USA, within 30 days after Felix Instruments 
has received written notice of the defect at the customer’s 
expense. No other arrangements may be made unless 
otherwise approved in writing by Felix Instruments. 
 
The use of this equipment constitutes Buyer’s acceptance of the 
terms set forth in this warranty. There are no understandings, 
representations, or warranties of any kind, express, implied, 
statutory, or otherwise (including, but without limitation, the 
implied warranties of merchantability and fitness for a 
particular purpose), not expressly set forth herein. 
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Warranty Registration Card 

 
1554 NE 3rd Ave, Camas, WA 98607, USA 
Phone: (360) 833-8835  Fax: (360) 833-1914  e-mail: sales@felixinstruments.com Web: www.felixinstruments.com 
  

PRODUCT REGISTRATION CARD 

Please complete and return this form to Felix Instruments within 30 days to validate your Warranty on Parts & Labor. 
    
Registration 
Information: 
  

Your Name:____________________________________ Title:__________________ 

Company/University:___________________________________________________ 

Address:_____________________________________________________________  

City:____________________________ State:__________ Zip:__________________ 

Country:__________________________Email_______________________________ 

Phone:______________________________ Fax:____________________________ 

Felix Instruments Serial Number(s):__________________________________________________  

Purchase Date:_____________________Purchase Price:_____________________  

------------------------------------------------------------------------------------------------------------------ 
FOLD ON DOTTED LINE 

   
  
Your opinions will help improve our service. Please answer the following questions. 
 
1. What was the basis of your product selection? 
□ Representative Recommendation    □ Price 
□ Product Features     □ Product Design 
□ Technical Specifications     □ Brand Name 
□ Warranty       □ Service 
□ Other _________________________________________ 
 
2.  What other competing brands did you consider? __________________________ 
 
3. Where did you first learn of this product? 
□ Advertisement in ________________________________   □ Representative 
□ Friend/Colleague     □ Exhibit 
□ Other _________________________________________ 
 
4. Who selected this product? 
□ I did      □ Research Group 
□ University Department     □ Purchasing 
□ Other _________________________________________ 
 
5. Comments/Suggestions:  
______________________________________________________________________ 
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